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The hardest part about learning a new development environment, whether it be a new
language, GUI, API, database, or just about anything else, is locating the “right” starting
point to get your project kicked off. This is quite like the “blank page” syndrome some
writers feel when starting a new project.

In most books about a new language, this is addressed by the obligatory “Hello World”
application, which serves as an introduction to the environment as a whole, including the
proper syntax to write, compile, and execute your applications.

In that same vein, this simple step-by-step guide was created to show you each piece of
the environment needed to start a new Visual Studio C project accessing the Btrieve APIL.
One of the major issues with such a document is that the user interface changes over
time, making the guide useless to a true beginner. To that end, please be aware that some
UI elements here may not match exactly what you see, but you should be able to track
down the right spot with a bit of hunting.

Prerequisites

This document assumes that you already have the development environment and database
engine installed and functioning. Specifically, this guide contains UI images from Visual
Studio 2019 and Actian Zen v14, but whatever version you have should at least be similar
enough to follow along. If you need help installing these two components, then refer to
the documentation for each component as needed.

Downloading and Installing the Btrieve SDK

In addition to the development environment, you will need the Btrieve SDK download
from Actian. As of this writing, you can find this file at:

https://esd.actian.com/product/Zen_PSQL

Select the SDK release and Btrieve platform as shown here:

%

Electronic Software Distribution

SELECT VIA PRODUCT or  Select Via Flatform

PRODUCT: RELEASE: PLATFORM:

Actian Zen (PSQL) v SDKs v | Btrieve v |

Then from the list of downloads available, download the Btrieve component, which
typically starts with the text “Zen-SDK-Btrieve-Windows”. As of this writing, the file is
fully named:

Zen-SDK-Btrieve-Windows-noarch-14.20.012.000.exe
When you run this file, you will get an Extraction dialog box that looks like this:
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WinZip Self-Extractor - Zen-5DK-Btrieve-Windows-nearc... X

To unzip all files in this self-extractor file to the

specified folder press the Unzip button. L
Run WinZip
Unzip to folder:
|C:'-.Deve|0p'-—.BtrvSDK] Browse. ..
Cverwrite files without prompting About
Help

Provide a proper path for the files to be extracted and remember where you put them!
Some people like to explode these files into each project to keep everything complete.
However, upgrading a large number of projects to new SDK components gets
complicated, so I prefer to keep everything in one centralized folder for inclusion into
each project from there.

This will create two folders, DOC and INTF, in the target folder. The DOC folder
contains documentation on the API calls in PDF format. The INTF folder, on the other
hand, contains the real “meat” of the interface components, including subfolders for C,
CBuilder, Delphi, Pascal, and VB.Net2010. There is one other critical folder called
IMPLIB that contains the import libraries, which we will use when linking.

For this project, we are going to work on a C application, so let’s drill a bit further down
into the C folder and see what is in each file, in alphabetical order:

e BLOBHDR.H: This file contains the definitions of constants and data structures
needed for Chunk operations. Chunk operations are a bit complicated, and will
not be covered here, but it is far easier to use these definitions than to attempt to
write your own.

e BTISTRUCT.H: This file contains other structure definitions and constants for
the CREATE and STATEXTENDED operations, among others.

e BTITYPES.H: This file contains platform-independent type definitions for the
various Btrieve data types, which is important as some compilers use different
definitions for the same types (e.g. “long long” = “LARGE INTEGER” = “signed
__int64”). This header file makes it possible to simply use BT LONGLONG or
BTI INT64 in your own code, and let the translation occur in the header.

e BTRAPI.C: This C source code module actually provides the definition for the
BTRYV and BTRVID functions, which handle some of the extra load required to
call BTRCALL and BTRCALLID by simply wrapping these operations to make
them easier to use.

e BTRAPLH: This header file provides the definitions for the functions in
BTRAPI.C and should be included in your own code.

e BTRCONST.H: Another important header file you should include directly into
your application, this one defines many of the commonly-used constants, such as
the operation codes, file open modes, status (return) codes, key type numbers, and
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more. While you certainly do not need to leverage these constants, doing so can
make your code much more readable.

e BTRSAMP.C: This is Actian’s equivalent of the Hello World application, this
sample code shows you how to do some of the basic operations, such as creating a
Client ID, making a Version call, opening a file, reading a record, creating a new
file based on the old one, reading records with a GetNextExtended call, and
inserting records into the newly-created file.

e BTRVEXID.H: This header file is new for PSQL v13 and newer, and provides
the interface definitions for the BTRVEX and BTRVEXID functions. These
functions are available ONLY in v13 and newer, but are required if you intend to
access any database files (in v13 format) that contain more than 4 billion records
or are larger than 256GB in size.

e LOGINAPILC: Another sample file, this one demonstrates how to use the Btrieve
Login API function.

e MAKEFILE: This makefile is provided for older command-line compilers, so
you might never need this.

The last file you will need for your application is located in the IMPLIB folder. The file
W3BTRV7.LIB will contain the library definitions from the core interface DLL
(W3BTRV7.DLL) which is linked into your application to provide the BTRCALL
functions used to access the Btrieve API from 32-bit applications. If you are writing a
64-bit application, then you will instead use the W64BTRV.LIB and DLL.

AN IMPORTANT NOTE ABOUT PACKING

If you look at the header file BTISTRUCT.H, you will see that it repeatedly wraps each
structure definition inside a #pragma pack(1) statement. This is done because most
Btrieve structures are packed with single-byte alignment, whereas the default compiler
option may be to pack on a 4-byte boundary. This can be better explained with the
following structure definition:

typedef struct

{
BTI UINT32 Valuel;
BT I_BYTE Value?2;
BTI UINT32 Value3;

} MY DATA STRUCTURE;

With byte alignment (i.e. pack(1)), this data structure will be 9 bytes in length. However,
with the default 32-bit alignment (i.e. pack(4)), the compiler will insert 3 bytes of filler to
align the Value3 variable on a longword boundary, and this structure will actually be 12
bytes long. This is done for performance reasons at the CPU level.

In itself, alignment is immaterial, but if you are trying to match an existing definition,
you may find that the data is shifted when you read or write it, and this can cause much
wailing and gnashing of teeth as nothing lines up correctly.

In short, be sure to force all of your own data structure definitions to pack(1) as well!
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Now that we’ve got THAT out of the way, let’s dig right in!

Creating a New Visual Studio Project

The first step to building our new application is to create a new project in Visual Studio.

= [m] X

Visual Studio 2019

Open recent Get started

| Pl Cé Connect to a codespace
Create and manage cloud-powered development
environments
4 Yesterday
(%] Blrvinterceptorvoxproj 25202 ' Clone a repository
Ci\Develop\Win32\Btrvinterceptor Get code from an online repository like GitHub or
. Azure DevOps
4 This week
[*y] Gssyncvexproj 1/21/2022 8:34 AM a@ Open a project or solution
0 AWin32\GSSy
C\Develop\Win32\GSSy Open a local Visual Studio project or .sln file
4 This month
ListStat.vexproj 1/7/2022 2:15 PM
B4l P = f\E e - Open a local folder
MLIEERY DRl Y =i Mavigate and edit code within any folder
@ GSRecovervexproj
C\Develop\Win32\Lowl evel\GSRecover ?*Ij" Create a new prOjECt
- q Choose a project template with code scaffoldin
(%] Dxutilvexproj to get sta:edJ P ¢
C:\Develop\Win324\DXUtil
4 Older Continue without code =

For this simple project, we are going to create a console application that be run directly
from a command line, so we’ll select this option next:

- ] X
Create a new project Seach fo templates (A1) »-
Recent project templates Alllanguages - Allplatforms = Allproject types -
Alist of your recently accessed templates will be o3 EEmEE
displayed here. \
1 Start from scratch with C++ for Windows. Provides no starting files,
C+=  Windows  Console
ﬁ‘ Console App
Run code in a Windows terminal. Prints "Hello World" by default.
C++=  Windows  Console
n CMake Project
Al s madern, cross-platfarm C++ apps that don't depend on sln or wexproj files.
C++=  Windows  Llinux  Console
Efl‘ Windows Desktop Wizard
z Create your own Windows app using a wizard.
C+=  Windows  Desktop  Console  Library
Windows Desktap Application
A project far an application with a graphical user interface that runs on Windaws,
C++  Windows  Desktop
=PY Bython Application
Back Next
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We then name the project and create the project folder, then click Create:

Configure your new project

Console App ¢+ Windows  Console

Project name

| BtrieveTest ‘

Location

| C\Develop| |-

Solution name )

| Breretes |

[] Place salution and project in the same directory

This will now create the project and a smattering of starting files, as shown here:

05(C) » Develop » BtrieveTest » BtrieveTest

MName

++ BtrieveTest.cpp

% BtrieveTestvexproj

B BtrieveTestvoxprojfilters
{3 BtrieveTest.vexproj.user

The source code file, BtrieveTest.CPP, contains starter “hello world” code for you
already:
erieveTest.cop -+ < | —

[ BtrieveTest - (Global Scope)
1 fo/ BtrieveTest.cpp : This file contains the 'main’ functien. Program executien begins and ends there.
2 1
3
4 #include <iostream>
5
5 Eint main()
7t
8 std::cout << "Hello World!'n";
o |}
10
11 =1// Run program: Ctrl + F5 or Debug > Start Without Debugging menu
12 // Debug program: F5 or Debug > Start Debugging menu
13
14 =// Tips for Getting Started:
15 // 1. Use the Solution Explorer window to add/manage files
16 /f 2. Use the Team Explorer window to connect te source control
17 // 3. Use the Output window to see build output and other messages
18 // 4. Use the Errer List window to view errors
19 // 5. Go to Project > Add New Item to create new code files, or Project > Add Existing Item to add existing code files to the project
20 // 6. In the future, to open this project again, go te File > Open > Project and select the .sln file

In fact, you can (and probably should) compile this code immediately and verify that it
works as expected.
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Import Needed Files from the Btrieve SDK

If you expect to be building many different projects, then you will be better off setting up
your development environment with a single set of SDK files. This can be done by
creating a folder at some higher level where the files can reside, or it can be done by
adding the SDK folder to the the Additional Include Directories value in your project
properties:

BtrieveTest Property Pages ? X

Configuration: | All Configurations ~ | Platform: | Active{Win32) ~ Configuration Manager...

4 Configuration Properties A Additional Include Directories
General Additional #using Directories
Additional BMI Directories
Additicnal Module Dependencies
Additional Header Unit Dependencies
Debug Information Format «different options>
Support Just My Code Debugging <different options>
Cammnn lannnane RunTime Supno rt

General
Optimization

Note that when configuring something like this, you should set the Configuration option
to “All Configurations”. If you leave it set to Debug or Release, then you’ll quickly dfind
that you have to make the change multiple times.

However, if you are building a single project, then it is simple enough to copy the needed
files from the Btrieve SDK download into your project folder, and this is the solution we
will use here.

1. First, copy the files you intend to use from the SDK folder into your project
folder. In this case, we expect to use BTRCONST.H, BTITYPES.H, BTR,
BTRVEXID.H and BTRAPI.H header files, as well as the BTRAPI.C source file.

2. Then, from the INTF folder, copy over the appropriate library file. IN this case,
we are building a 32-bit application, so I’m bringing over W3BTRV7.DLL from
the WIN32 folder.

3. In Visual Studio Solution Explorer, right-click the Header Files line and add each
header file in turn:

Salution Explorer A=
@alo-sam "
Search Solution Explorer (Ctrl+;) @ ~

121 Solution ‘BtrieveTest' (1 of 1 projec]
4 [%] BtrieveTest

b =@ References
3 Exten |Dp nden
HE'* r Fila:
Add Pl Newd Ctrl+ Shift+ A

5°E= Class Wizard... Ctrl+Shift+ X |:| Existin gltm ShftA\t+A

4. Do the same for the BTRAPI.C file in the Source folder.
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You’ll now have a solution that looks like this:
Solution Explorer * B8 X
WE o-sam "
Search Solution Explorer (Ctrl+;) 0 ~
3] Solution 'BtrieveTest' (1 of 1 projec
4 [%] BtrieveTest
I =B References
[ External Dependencies
4 y Header Files
[A btitypes.h
[A btrapi.h
btrconst.h
btrvexid.h
4 o Source Files

4
4
4
4

1 Resource Files
b [ btrapi.c
B *++ BtrieveTest.cpp

If you attempt to build the solution now, you will get an error about a missing directive.
(Try it and see for yourself!) This brings us to the next step, configuring the project.

Configure the Project Compiler and Linker Options

With platform-independent header files, we have to tell the preprocessor which platform
we are building for. While it may be tempting to simply add a #define right into the top
of your source code, you should avoid doing this. At some point in the future, you may
want to target a different environment (e.g. 64-bit Windows), and changing this in the
compiler options is simply easier in the long run.

As we are building a 32-bit application, we need to define the compiler directive
“BTI_WIN_32” so that the proper definitions are constructed at compile-time. To do this,
open your project properties screen again, make sure that “All Configurations” is
selected, and go to the C/C++ Preprocessor options, and add the definition to the top line:

BtrieveTest Property Pages ? x

Configuration: | All Configurations ~ | Platform:  Active(Win32) ~ Cenfiguration Manager...

4 Configuration Properties  ~
General
Advanced
Debugging

Preprocessor Definitions
Undefine Preprocessor Definitions

Undefine All Preprocessor Definitions Mo
Ignore Standard Include Paths Ne
Preprocess to a File No

WIN32;BTI_WIN_32;<different options> ~

VC++ Directaries
4 CfCesr
General
Optimization
Preprocessor
Code Generation

Preprocess Suppress Line Numbers Mo
Keep Comments No
Use Standard Conforming Preprocessor

Now, the code will compile successfully, but you will now get linker errors:

error LNK2019: unresolved external symbol _BTRCALL@28 referenced in function _BTRV@24
error LNK2019: unresolved external symbol _BTRCALLID@32 referenced in function _BTRVID@28

To fix this, we ALSO need to tell the compiler about the linker library.

1. Go back to the Project Properties page and verify that All Configurations is
selected.

2. Open the Linker section and go to the Input page.
Add the LIB file to the Additional Dependencies screen.
Information Provided By Goldstar Software Inc.

http://www.goldstarsoftware.com
Page 8 of 13




BtrieveTest Property Pages ? X

Configuration: | All Configurations ~| Platform: | Active(Win32) ~| | Configuration Manager...

Additional Dependencies WBBTRV?.LIB;'cemaIBE‘Im;user32‘hb;gd\}l.\\b;wmspuu\.hb;c ~

Ignore All Default Libraries
Ignore Specific Default Libraries

4 Configuration Properties  ~
General
Advanced

Debugging Module Definition File

VC++ Directories Add Module to Assembly
b C/Ce+ Embed Managed Resource File
4 Linker

Force Symbol References
Delay Loaded Dlls
Assembly Link Resource

General

Input
Manifest File

NOW, you can compile and run your program, and it will work! Of course, it only
outputs a simple “Hello World” message and does nothing with the database, but that’s
the majority of what is needed to get VS configured.

Compile the Sample Btrieve Code

Once we have the environment ready, we can compile the sample code. IN this case, we
are going to take a shortcut and simply coipy ALL of the text from the BTRSAMP.C file
provided in the SDK into out BtrieveTest.CPP file in Visual Studio. This will now look
like the following:

btrvexid.h btitypes.h btrconst.h btrapi.h BtrieveTest.cpp® = )(_

¥ BtrieveTest - (Glok

1 B AR T P P P P P P D P PP P D
2 w
3 ** Copyright 2814 Actian Corporation All Rights Reserved
5 e R e
6 Il R e e e L L L L S LR
7 BTRSAMP.C
g This is a simple sample designed to allow you to confirm your
9 ability to compile, link, and execute a Btrieve application for

1@ your target environment using your compiler tools.

12 This program demonstrates the C/C++ interface for Btrieve for DOS,

13 Extended D05, 052 (16 and 32-bit), MS Windows, NetWare NLM, MS

14 Windows NT, Windows 95, and Linux.

15

16 This program does the following operations| on the sample database:

17 - gets the Microkernel Database Engine wersion

18 - opens sample.btr

19 - gets a record on a known value of Key @

26 - di=znlavs the retrieved record

If you’re impatient, you might try to immediately compile the new code. If you took the
extra time to add your header files into the Include path, then you may be delighted to
find that it works. However, if you are following these instructions, you’ll get a boat-
load of undefined identifier messages.

The cause of these errors is in the way the header files are included, with angle brackets,
which assume they are in the standard include path. Change lines 47 and 48 to use quotes
instead:

A3 ddmkkkkdk kR kR ke ke ke ke Rk

S#include <stdlib.h>

S
S

|

45 #include <stdio.h>
45 #include <string.h>
47 #include "btrapi.h"
43 #include “btrconst.h"
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Now, everything SHOULD work. However, when we compile and link on Visual Studio
2019, we still get 4 error messages:

7 Code Description +
2 ED51 a value of type "void ™ cannot be assigned to an entity of type "GNE_BUFFER_PTR"
€3 €499 'strepy’: This function or variable may be unsafe. Cansider using strcpy_s instead. To disable deprecation, use _CRT_SECURE_NO_WARNINGS. See online help for details.
€3 4996 ‘strepy’: This function or variable may be unsafe, Consider using strepy_s instead. To disable deprecation, use _CRT_SECURE_NO_WARNINGS. See online help for details.
€3 2240 'z cannot convert from 'void *' to 'GNE_BUFFER_PTR'

While this code worked originally when Actian built the sample code, Microsoft made
some changes in more recent Visuial Studio editions which broke a few things.

The first change makes it impossible to cast a VOID * to a pointer of another type. We
fix this by adding a forced cast to the GNE_BUFFER_PTR in line 441:

gneBuffer = (GNE_BUFFER_PTR) malloc(sizeof(GNE_BUFFER));

This leaves us with the two “unsafe” messages, which stem from the old string handling
library. Back in the “good old days”, you simply called strepy() to copy a string, and the
string library copied bytes until the first NULL byte was seen. However, if you didn’t
allocate a large enough target buffer, this could overwrite memory or cause access
violations. In an attempt to force developers to be more cognizant of memory errors (and
make code more stable), Microsoft created new functions (like strepy_s()) that ALSO
require the target string length as a paramater. These functions validate the data as it is
being copied to prevent a memory overwrite.

In older versions of Visual Studio, these issues simply caused warnings to appear, but
newer versions of Visual Studio flag these as hard errors. There are two ways to fix it:

¢ You can set the compiler directive  CRT SECURE NO WARNINGS (in the
same place you defined BTI WIN 32). This will disable all of these warnings
and allow your code to compile. Of course, if you overwrite memory, strange
results are your own fault.

e You can change all of the calls to use their secure variants. This requires
changing the function name and adding the extra target length parameter. Note,
though, that this can make your code less portable to a different compiler in the
future.

We’re going to use the Microsoft recommendation and change lines 308/309:

strcpy_s((BTI_CHAR*)keyBufl, 255, FILEL NAME);
strcpy_s((BTI_CHAR*)keyBuf2, 255, FILE2 NAME);

Think you’re done now? Indeed you are! The project now compiles and runs!
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Directory of C:\Develop\BtrieveTest\

However, if you look closely, you’ll see that we get an error (35) when this is running.
Looking up this error in the header file, we find that this equates to “B_DIRECTORY_ERROR”.
This error is returned because Actian changed the default location of the SAMPLE.BTR
file between the time this sample code was created and the current v14/v15 releases.

Thankfully, fixing it is as easy as changing PSQL to Zen in two lines, 65/66:

#define FILE1_NAME "c:\\ProgramData\\Actian\\Zen\\samples\\sample.btr"
#define FILE2_NAME "c:\\ProgramData\\Actian\\Zen\\samples\\sample2.btr"

Rebuild the application and run it, and you should now get a full test run of the sample
code which opens a file, reads a record and displays some data from it, then copies a set
of records from one file to another. Whee!
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-8

Closing Remarks

We have covered most of the more maddening issues that you’re likely to run into
thoughout this paper. However, I’d like to leave you with a few additional thoughts:

e If you switch between DEBUG and RELEASE modes in your application and
things suddenly don’t build properly, check the configuration settings. It is
VERY common to modify the project settings and forget to change the
Configuration box to All Configurations. You then make a required change, and
when you switch to the other config, it breaks. Be very careful and always check
this box!

e In order to force structure alignment on a byte boundary, it used to be common to
set this as a compiler option (/Zp1), which you can do here:

BtrieveTest Property Pages ? X
Configuration: | All Configurations | Platform: | Active(Win32) ~| | Configuration Manager...
4 Configuration Properties  » Enable String Pooling
General Enable Minimal Rebuild Mo (/Gm-)
Advanced Enable C++ Exceptions Yes (/EHsc)
Debugging Smaller Type Check No
VC++ Directories Basic Runtime Checks <different options>
4 C/Ces Runtime Library «different options>
SR St ember gmene——— IR v
ST Security Check Enable Security Check (/GS)
Preprocessar 3 Control Flow Guard
Code Generation
rp— Enable Function-Level Linking «different options:>

However, some newer Visual Studio libraries simply cannot be used when called
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with byte alignment, and the linker will spit back errors if you try this. As such,
you will want to be sure to always use pragma statements to force alignment
around your Btrieve structures. Better yet, you can use the pragma stack to
preserve the original alignment outside of your code. This wills like this:

#pragma pack (push, 1)
typedef struct
{
BTI_UINT32 Valuel;
BTI BYTE Value?2;
BTI UINT32 Value3;
} MY DATA STRUCTURE;
#pragma pack (pop)

e [fyou will be building multiple projects over the years, then be sure to spend
some time up front learning how to set up the default libraries, so that you can
avoid copying the header and BTRAPI.C files into each project as you go along.
A bit of time setting up the environment up front can save you hours of effort in
the long run.

e Ifyouuse anewer SDK (from v13 and above) to build an application, then you
may find that this application refuses to run on the older environments (v12 and
older) due to a missing link for the BTRVEX function. This is caused by the
newer SDK Library (W3BTRV7.LIB) including the function definitions for the
BTRVEX and BTRVEXID functions. You can prevent the loader from resolving
every symbol when the program loads by setting the Delay Loaded Dlls option
for this file:

BtrieveTest Property Pages ? x

Configuration: | All Configurations ~| Platform: | Active(Win32) «| | Configuration Manager...

4 Configuration Properties A

Additional Dependencies 'W3BTRVT.LIB;kernel32.lib;user32.lib;gdi3 2 lib;winspool. +
Ignore All Default Libraries

gnore Specific Default Libraries

Medule Definition File

Add Module to Assembly

Embed Managed Resource File

Force Symbol References

Delay Loaded Dlls W2BTRVT

Assembly Link Resource

e Ifyou are looking to use other functions, such as the Distributed Tuning Interface
(DTTI) which affords access to the configuration and monitoring of the database
environment, you will need another SDK download (Zen-SDK-DTI-Windows-
noarch-14.20.012.000.exe) which, in turn, includes the needed header and import
library files. Setup is similar to that which is covered here.

Of course, if you still can't get it to work, contact Goldstar Software and let us help!
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